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Starting LawTime  

¶ LawTime starts automatically when you start your computer. If you have closed LawTime 

manually, start the program by clicking LawTime icon 

 

LawTime  small window  

¶ LawTime small windowΧ 

 

Χ has two main functions: 

1. Clock-button starts new timer. 

2. Leftmost button opens LawTime main window. 

 

¶ Close ( ) button hides LawTime window. To display it again, click on LawTime icon 

  
  

¶ If you close the program before saving data, the unsaved timers will remain active until you 

restart the program 

¶ Right click on timer opens a menu 
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Timing  

Starting the timer  

¶ Press the clock-button ... 

 

Χ ŀƴŘ ǘƘŜ ǘƛƳƛƴƎ ōŜƎƛƴǎ Χ 

 

¶ Click on timer opens a data entry window and timer stops 

Enter th e data 

 

¶ Enter/select relevant data about customer, case etc 

¶ Do one of the following: 

- select from list 

- start typing in list box for quick search 

¶ If the measured time and actual duration of the work are different, enter the number 

manually  

¶ Field "Duration" specifies billable time. Gray area shows the duration as it will be shown on 

invoice (rounding rules applied) 

¶ α9ƴŘά time is used only to display the duration in calendar, start time and duration will be 

used for billing 

¶ ¢ƻ ŎŀƭŎǳƭŀǘŜ ά5ǳǊŀǘƛƻƴέ, based on start and end time, press  button 

¶ Enter the dǳǊŀǘƛƻƴ ŀǎ άмƘ олƳέΦ ̧ ƻǳ Ŏŀƴ ŀƭǎƻ ǳǎŜ άмΦрƘέ ƻǊ άфлƳέ 

¶ Price is automatically chosen according to selected employee, customer etc 
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¶ Total is calculated automatically 

¶ Comments are displayed on invoice specification 

¶ Use comment templates to simplify data entry. List of comment templates come from 

settings (Settings -> Comment templates) and from comments used before 

¶ Click on  to view comments entered for this customer or case. To select a comment: 1) 

doubleclick on the row, 2) ǎŜƭŜŎǘ ŀ Ǌƻǿ ŀƴŘ ŎƭƛŎƪ άǇŀǎǘŜ ŎƻƳƳŜƴǘέ ƻǊ άǇŀǎǘŜ ŘŀǘŜ ŀƴŘ 

ŎƻƳƳŜƴǘέ or оύ ǎŜƭŜŎǘ ŀ Ǌƻǿ ŀƴŘ ǇǊŜǎǎ άŜƴǘŜǊέ. On invoice, comments with the same data 

will be added together as one row 

¶ Set the language in customer or case settings to see the icon   (English) near comment 

field 

¶ When done, click  

¶ To hide the window, click on  button 

¶ To pause and/or continue timing click on  button 

 

More possibilities  

 

¶ You can use more than one timer at the same time. This helps you to solve easily the 

ǎƛǘǳŀǘƛƻƴ ǿƘŜƴ ȅƻǳΩǊŜ ƛƴ ǘƘŜ ƳƛŘŘƭŜ ƻŦ ƭƻƴƎƭŀǎǘƛƴƎ ǿƻǊƪΣ ōǳǘ ƻƴŜ ƻǊ ǎŜǾŜǊŀƭ ǎƘƻǊǘ-term works 

are done at the same time.  

Activating new timer will pause the others 

 

 
 

¶ Vertical layout displays timers in a vertical view, showing also customer and case information 

(if data entered before) and pause-button 

 

 
 

¶ Button  next to a selection area opens a menu with show all, open, new and refresh 

options 

¶ Button  next to selection area opens a calendar to select the time and date 

¶ Click on timer to hide the data entry window (timer will remain paused) 

¶ To pause or/and continue timing, do one of the following: 

1. Press on arrow next to timer, click pause. Do the same to exit pause. 
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2. Click and hold the left mouse-button on timer to start or exit pause. 

3. To pause the timer, click on  and to continue timing click on . 

 

 
 

¶ tǊŜǎǎ ά{ŀǾŜ ŀƴŘ ƴŜǿέ ǘƻ ǎŀǾŜ work and leave data entry window open 

 

 

Use this option with the same data for example: 

1. If in addition to hourly rate, international phonecall is billed. 

2. If same work was done by several employees.  
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Main window  

 

 

Press left-button to open main window. 

The structure of main window  

 

 

3 zones of main window: 

1. Table selection. Click to select a module. 

2. Viewing options. Table settings, filters etc.  

3. Content. Table content. 

  

 2 

 1 

 

     3 
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Work with tables  

You can change the look of tables by: 

¶ Sorting 

Click on column heading to sort the table. Click again on same field to reverse sort direction.  

¶ Grouping 

The header of the table shows groups used. Drag a column header there to group by that column 

and display subtotals. 

¶ You can group by more than one field. 

 

 

¶ Autofilter 

Arrow-button in column header opens an autofilter menu. 

Click on a value to filter table data. 

 

 

Date column allows you to select year, months and day.  
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¶ Choose colums to show in the table 

Click on Fields Χ 

  

Χ choose colums to be shown in the table: 

  

¶ Save the table settings 

To save the table, click on View > Table settings > Save as new. 

 

 
 

Later, you can restore view settings by one click: 
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¶ Output table data 

You can print, save in a file, send to mail recepient as PDF, copy to Excel etc. 

 

See also 

¶ LawTime main window on page 9 

¶ Activities on page 13 

¶ Customers  on page 19 

¶ Cases on page 23 

¶ Invoices on page 26 

¶ Prices on page 32 
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Activities  ð viewing measured  work  

Viewing o ptions  

Calendar 

Use calendar-look to get an overview of workday, week or month. 

 

 

You can use filters to display the data you need, or select dates from calendar. 

Table 

Use the table-look to get an overview of measured work. 

You can choose filters (from left-menu of the main window) to display the data. 
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You can also: 

¶ print the table, save in a file, send to mail recepient as PDF, copy to Excel etc 

¶ show and hide the table fields 

¶ sort 

¶ group in different levels (subtotals) 

¶ save table settings to display them later 

¶ use filters (similar to Excel AutoFilter) 
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Filt ering activities  

 

Use the filter to view activities which correspond to selected criteria. 

For example, if you select a customer, then you will see activities only for this customer. But if on 

customer field all is selected, then you will see activities of all customers. 

Use Period list to select from most frequently used time ranges. 

Click Filter to apply your selections. 

Use autofilters for a quick filtration. 

Allow multiple choices help you to select different objects (e.g. ƛƴ ŎǳǎǘƻƳŜǊΩǎ ƻǊ ƻǘƘŜǊ ŎƻƭǳƳƴύ ŀǘ ŀ 

time. 

 



16 
 

Date column allows you to select year, month and day: 
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Flag the activities ready to bill  

άCƭŀƎέ ŎƻƭǳƳƴ ƛƴ ŀŎǘƛǾƛǘƛŜǎ ǘŀōƭŜ ƛǎ ǘƻΥ мύ ƳŀǊƪ ŀŎǘƛǾƛǘƛŜǎ ǊŜŀŘȅ ŦƻǊ ōƛƭƭƛƴƎ ŀƴŘ 2) view the status of the 

bill. 

 

 

According to privileges a user can flag: 1) his/her own activities, 2) activities, where the user is a 

manager of the customer or the case, 3) all the activities. 

Use a column in the main window to flag the activities: 

To flag the activity ready tƻ ōƛƭƭΣ ŎƭƛŎƪ ƻƴ άŎƭŜŀǊ ŦƭŀƎέ . The colour of the flag turns green , which 

means that the activity is flagged άǊŜŀŘȅ to billέ. Doubleclick marks the activity άƴƻǘ ǘƻ ōƛƭƭέ - . To 

unmark the activity, click one more time on the flag - ǘƘŜ ŦƭŀƎ ƛǎ άŜƳǇǘȅέ ŀƎŀƛƴΦ 

To select a group of activities άready to billέ, click on the group header row:
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Right click on selected rows opens a menu with options: 

 

 

Create a view  

To view or edit flagged activities, use the main window Activities section. 

To view activities with different billing statuses, create a view. CƻǊ ŜȄŀƳǇƭŜΥ άέBill neededέ ŀƴŘ άBill 

emptyέΦ 

The vƛŜǿ άBill neededέ shows all the activities which are flagged άready to billέ. This view gives you a 

quick overview of the customers and activities to bill.  

To create this view use filter (date, customer, case, comments) in the main window and sort the 

ŎƻƭǳƳƴ ƴŀƳŜŘ άBill statusέΣ ŎƘŜŎƪƛƴƎ άBill neededέ. 

¢ƘŜ ǾƛŜǿ άBill emptyέ ǎƘƻǿǎ ŀƭƭ activities which are waiting to be flagged for billing.  

To create this view, use filter (date, customer, case, comments) in the main window and filter the 

ŎƻƭǳƳƴ ƴŀƳŜŘ ά.ƛƭƭ ǎǘŀǘǳǎέΣ ŎƘŜcking ά9ƳǇǘȅέΦ 
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Bill status  

 The activity is not flagged 

 ¢ƘŜ ŀŎǘƛǾƛǘȅ ƛǎ ŦƭŀƎƎŜŘ αǊŜŀŘȅ ǘƻ ōƛƭƭά  

 Do not bill the activity  

 The bill is being composed, but is unconfirmed  

 The bill is composed, confirmed, but not received yet 

 The bill is composed, confirmed, and received  

 The bill is overdue  

 

Customers 

Adding customers and viewing d ata 

To find the customer data, do one of the following: 

1. Subdivison ά/ǳǎǘƻƳŜǊǎέ in Ƴŀƛƴ ǿƛƴŘƻǿΦ /ƭƛŎƪ άbŜǿέ ǘƻ create new customer. 

2. Click on  -button next to customer selection any place in LawTime, to open or create a 

customer.   
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Customer data  

General 

 

Name ς the name of the customer. 

Short name - is displayed e.g. in LawTime main window to view activities. 

VAT code ς VAT code used for this customer. 

Division ς select a division for this customer. 

Contract date - the date, when contract was signed. 

Contact number ς ŎǳǎǘƻƳŜǊΩǎ ŎƻƴǘŀŎǘ ƴǳƳōŜǊΦ 

Comments ς add comments about this customer. 

Address ς ŎǳǎǘƻƳŜǊΩǎ ŀŘŘǊŜǎǎΦ 

Active ς ǿƘŜƴ άŀŎǘƛǾŜέ ƛǎ ŎƘŜŎƪŜŘΣ the customer will be shown in selection lists. 

Export customer ς tick the checkbox to mark customer as export customer. 

Mail settings ς tick the checkbox (Newsletters; Christmas cards; Invoices by E-mail; No paper 

invoices) you need to consider when composing e-mail to this particular customer. 
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Details  

 

Details tab specifies data for this customer: 

Default activity type specifies activity type used in new activities for this customer. 

Language is default language for this customer. Language icon  is shown in the right corner of 

comment field. Enter comment template texts according to language settings (see also on page 46). 

Currency is default currency, used on invoices for this customer. 

Invoice due days goes automatically on invoice, after entering the invoice date. 

VAT calculation ς VAT % used on invoices for this customer. 

Invoice layout ς determines how invoice parts are organized on paper. 

Invoice letterhead ς controls invoice headers and footers: bank details, addresses, contact 

information, your company logo etc. 

Customer ID ς customer ID in external system (e.g. accountancy). 

Postal address - ŜƴǘŜǊ ŎǳǎǘƻƳŜǊΩǎ postal address ƛŦ ƛǘΩǎ ŘƛŦŦŜǊŜƴǘ ŦǊƻƳ ŎǳǎǘƻƳŜǊǎ address. It displays 

automatically on invoice, after the customer is selected. 
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Cases 

 

List of ŎǳǎǘƻƳŜǊΩǎ cases (see also on page 23). /ƭƛŎƪ ƻƴ άbŜǿέ ǘƻ ŀŘŘ ŀ ƴŜǿ ŎŀǎŜ ǘƻ ǘƘŜ ŎǳǎǘƻƳŜǊΦ ¢ƻ 

ƻǇŜƴ ŎŀǎŜΣ ŎƭƛŎƪ άhǇŜƴέ ƻǊ ŘƻǳōƭŜŎƭƛŎƪ ƻƴ ŎŀǎŜ ǊƻǿΦ 

LŦ άcase required for activitiesέ ƛǎ ŎƘŜŎƪŜŘΣ ǘƘŜƴ ŎŀǎŜ Ƴǳǎǘ ŀƭǿŀȅǎ ōŜ ǎŜƭŜŎǘŜŘ ǿƘŜƴ ŜƴǘŜǊƛƴƎ ƴŜǿ 

activities for this customer. 

Prices  

 

List of customerΩǎ prices (see also on page 32). 
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Invoices 

 

List of customerΩǎ invoices (see also on page 26). 

Documents 

 

[ƛǎǘ ƻŦ ŎǳǎǘƻƳŜǊΩǎ ŘƻŎǳƳŜƴǘǎ ŦǊƻƳ {ƘŀǊŜtƻƛƴǘ website. 

Case 

Adding case and viewing data  

To open case data, do one of the following: 

1. Subdivison ά/ŀǎŜέ in main ǿƛƴŘƻǿΦ /ƭƛŎƪ άbŜǿέ ǘƻ ŎǊŜŀǘŜ ƴŜǿ ŎŀǎŜ. 

2. Click  -button next to case selection any place in LawTime to open or create new case.  

3. Click on Customer Řŀǘŀ ǿƛƴŘƻǿ ǎǳōŘƛǾƛǎƛƻƴ έŎŀǎŜǎέΦ 
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Case data 

General 

  

Case ς the name of the case (required). 

Short name is displayed e.g. in LawTime main window to view activities (otherwise the name may 

take too much room in table). 

Customer connected to this case. 

Contact ς the name of a company and/or person, who represents the customer.  

Employee ς name of a person, connected to this case. 

Opposing side ς opposing side of this case. 

Division - subdivisions, used to differentiate customers, cases, employees and invoices. 

Contract date ς the date, when contract was signed. 

Contract number ς the number of contract, connected to this case. When composing the invoice, 

after selecting customer, LawTime offers you a list on contract numbers to select. 

Comments ς add comments to this case. Comments are shown in main and case window. 

Active ς when Active is checked, the case will be shown in selection lists (e.g. when entering the 

data). 
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Details  

 

List of case details: 

Default activity type specifies activity type used in new activities for this case. 

Language is default language for this case. 

 Currency is default currency, used on invoices for this case. 

Invoice due days goes automatically on invoice, after entering the invoice date. 

VAT calculation ς VAT % used on invoices for this case. 

Invoice layout ς determines how invoice parts are organized on paper. 

Invoice letterhead ς controls invoice headers and footers: bank details, addresses, contact 

information, your company logo etc. 

Customer ID ς customer ID in external system (e.g. accountancy). 

Postal address - ŜƴǘŜǊ ŎǳǎǘƻƳŜǊΩǎ Ǉƻǎǘŀƭ ŀŘŘǊŜǎǎ ǘƻ ŘƛǎǇƭŀȅ ƛǘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƻƴ ƛƴǾƻƛŎŜΣ ŀŦǘŜǊ ǘƘŜ 

customer is selected. 

Prices 

List of caseΩǎ prices. 

Tasks 

[ƛǎǘ ƻŦ ŎŀǎŜΩǎ ǘŀǎƪǎΦ 

Invoices 

List of caseΩǎ invoices. 

Documents 

[ƛǎǘ ƻŦ ŎŀǎŜΩǎ ŘƻŎǳƳŜƴǘǎ ŦǊƻƳ {ƘŀǊŜtƻƛƴǘ ǿŜōǎƛǘŜΦ 
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Invoices  

Adding and viewing invoice  data 

To open invoice data, do one of the folllowing: 

1. Subdivison άLƴǾƻƛŎŜǎέ in Ƴŀƛƴ ǿƛƴŘƻǿΦ /ƭƛŎƪ άbŜǿέ ǘƻ ŎǊŜŀǘŜ ƴŜǿ ƛƴǾƻƛŎŜΦ 

2. Click on Customer data window subdivision έinvoicesέ. 

3. Click on Case Řŀǘŀ ǿƛƴŘƻǿ ǎǳōŘƛǾƛǎƛƻƴ άƛƴǾƻƛŎŜǎέ. 

Invoice window  

 

¶ Customer, who receives the invoice  

¶ Case 

¶ Postal address is filled automatically when customer (or case) is selected. You can also enter 

the address manually 

¶ Currency. Select the currency before you add billed work on your invoice. In that case, if 

necessary, LawTime converts prices into new currency  

¶ VAT calculation: "all 18%", "all л҈Ϧ Ǿƿƛ Ϧservices 0%, expenses 18%". If you choose the last, 

VAT % will be added according to activity type (service/expense) you entered. Use  -button 

to enter different tax rate 

¶ Confirmed: you see ά5w!C¢έƻƴ ǳƴŎonfirmed invoice. You can change data until the invoice is 

not confirmed. After the invoice is confirmed you can not edit it and you will no longer see the 

ǎƛƎƴ ά5w!C¢έ 

¶ Invoice No: after you select the date, invoice numbers appear (according to your settings) 

automatically from number series or you can add it manually 

¶ Date: enter the date or select it from the calendar 

¶ Due date: ŜƴǘŜǊ άŘǳŜ ŘŀǘŜέ or click  button to select number of due days 
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¶ Contract enables you to select or enter the contract number. Data in popup menu comes 

from customer or case data 

¶ Issued by: ǇŜǊǎƻƴΩǎ ƴŀƳŜΣ whose signature will be used on invoice 

¶ Division - subdivisions, used to differentiate customers, cases, employees and invoices 

¶ Invoice settings ς άƛƴǾƻƛŎŜ ǘȅǇŜέ ŘŜŦƛƴŜǎ ȅƻǳǊ ƛƴǾƻƛŎŜ ŀǎ ά{Lat[9έΣ άŎǊŜŘƛǘέ ƻǊ άǇǊƻ ŦƻǊƳŀέ  

Rows 

4 types of rows are used on invoice (upper left-corner of the table έ!ŘŘ ǊƻǿέύΥ  

1. άFrom saved activitiesέ ς data from measured or entered activities.  

2. άNew activityέ ς open a data entry window. A new row with the new activity will be added on 

invoice. 

3. έText rowέ ς simple text and/or manually entered sum. 

4. άExtra text under invoiceέ ς add more information. This row is seen in the bottom of invoice, 

under tax and total sum rows. 

 

άHiddenέ ƳŜŀƴǎ ǘƘŀǘ the row is hidden from printout, specification and from sum calculation field:

 

For example: use hidden rows if you have a fixed job payment and you have measured your work in 

LawTime. This enables you to add billed work on invoice, but the customer sees the sum according to 

your agreement. 

 

Adding billed work to invoice  

/ƭƛŎƪ έ!ŘŘ Ǌƻǿέ button: 

  

Χ and the pop-up menu opens with options: 
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Adding work: 

From saved activities 

1. /ƭƛŎƪ ƻƴ έCǊƻƳ ǎŀǾŜŘ ŀŎǘƛǾƛǘƛŜǎέ ƻǇŜƴǎ ŀ ǿƛȊŀǊŘΦ On the first page of the wizard you can select 

parameters to search for activities. 

 

Quick select offers a selection of defined periods: 

 

Date range enables you to choose year/month/day, i.e select a period you need information 

about. 

¢ƛŎƪ ƛƴ άReset pricesέ cancelles all prices selected on timing and uses currently active prices 

for all activities.  

/ƭƛŎƪ άNextέ to continue. 

2. Select fields according to which separate rows will be created on invoice. 

Seperate rows will always be used for different activity types and prices. 

9ȄŀƳǇƭŜΥ {ŜƭŜŎǘ έCaseέ ǘƻ ǇƭŀŎŜ ŀŎǘƛǾƛǘƛŜǎ ŦƻǊ ŘƛŦŦŜǊŜƴǘ ŎŀǎŜǎ on separate invoice rows. Leave 

άCaseέ empty to group activities for all cases to one row. 
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/ƭƛŎƪ έbŜȄǘέ ǘƻ ŎƻƴǘƛƴǳŜ. 

3. Invoice preview. You can unselect rows to be excluded and edit parameters before adding to 

invoice. 

 

²ƘŜƴ ŘƻƴŜΣ ŎƭƛŎƪ άFinishέΦ 

Text row 

/ƭƛŎƪ έText rowέ ǘƻ Ŧƛƭƭ ǘƘŜ ƛƴǾƻƛŎŜ ƳŀƴǳŀƭƭȅΦ 

 

Add additional bottom text to invoice in άExtra text under invoice” area. You can set a default text 

row for new invoices (see also on page 46). 



30 
 

Invoice delivery  

To deliver invoice, do one of the following: 

1. Print ς click on print-ōǳǘǘƻƴ ŀŦǘŜǊ ŜƴǘŜǊƛƴƎ Řŀǘŀ Χ 

 

 
 

Χ ƻǇŜƴǎ ŀ έLƴǾƻƛŎŜ ǇǊƛƴǘ ƻǇǘƛƻƴǎέ window. 

 

 
 

Choose invoice parts to print, and visual look of your invoice. 

Layout determines how different invoice parts are organized on paper. 

Letterhead controls invoice headers and footers: bank details, addresses, contact information, your 

company logo etc. Letterheads can be edited under LawTime settings (see also on page 46). 

Modifying invoice layout requires technical skills and tools, and cannot be done directly from 

LawTime. Contact LawTime distributor to make changes to invoice layouts. 

By default, letterhead and layout come from Customer (Customer window > Details) or language 

(Tools > Options > Invoice printing) data. 

 

/ƭƛŎƪ έhKέ ǘƻ open print preview.  

 

2. Save as PDF 

 

 
 

Χ opens a έLƴǾƻƛŎŜ ǇǊƛƴǘ ƻǇǘƛƻƴǎέ window. 

 

Select options, and ŎƭƛŎƪ έhYέΦ Choose a place to save the file.   
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3. Send to mail recepient as PDF or HTML – after entering data, click on Send to.

 
 

4. Send e-mail ς LawTime opens your default e-mail client (e.g. Outlook) and starts composing 

new mail, PDF file attached to it. 

 

 

 

Make ǘƘŜ ŎƘŀƴƎŜǎ ȅƻǳ ƴŜŜŘ ŀƴŘ ŎƭƛŎƪ έ{ŜƴŘέΦ 

To compose an e-Ƴŀƛƭ ǿƛǘƘ ŎǳǎǘƻƳŜǊΩǎ ŀŘŘǊŜǎǎ already on it, click on the arrow of έ{ŜƴŘ Ŝ-

Ƴŀƛƭέ ōǳǘǘƻƴ . Click on address opens your default e-mail client and starts 

composing new e-mail ǿƛǘƘ α¢ƻά-address filled. 

  

 
 

έNoneέ ƳŜŀƴǎ ǘƘŜǊŜΩǎ ƴƻ Ŝ-mail address entered on customerΩs data sheet. 

 

Invoice commands  

Shortcuts on άLƴǾƻƛŎŜǎέ Ƴŀƛƴ ǿƛƴŘƻǿΥ 
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To fasten your invoice making process, select a client in main the table and click on αLƴǾƻƛŎŜ 

ŎƻƳƳŀƴŘά shortcut you need. 

Payroll  

Payroll enables to divide the sum of an invoice according to measured activity times, purchased 

services or/and account managers etc enabling clear and precise overview of employee turnover. 

Every user has an access to view or edit payrolls according to user privileges: 1) view personal 

ǇŀȅǊƻƭƭǎΣ нύ ǾƛŜǿ ƻǘƘŜǊ ǇŜƻǇƭŜΩǎ ǇŀȅǊƻƭƭǎ or 3) edit payrolls. 

To use Payroll, open the invoice and click on the tab: 
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¶ /ƭƛŎƪ ƻƴ άAdd rowέ opens a pop-up menu with options άInvoice expensesέ ŀƴŘ άOther 

expensesέΥ 

 
¶ !ŘŘ ŀ Ǌƻǿ άInvoice expensesέ ǘƻ ŀǘǘŀŎƘ ŘƛǊŜŎǘ Ŏƻǎǘǎ ƻŦ ǘƘŜ ƛƴǾƻƛŎŜ ǘƻ ǘƘŜ ǇŀȅǊƻƭƭΦ ¢ƘŜǎŜ ŀǊŜ 

the activities wich activity type (see also on page 44) is set as expense. 

¶ !ŘŘ ŀ Ǌƻǿ άOther expensesέ ǘƻ ŀŘŘ ŜȄǇŜƴǎŜǎ Ƴŀƴǳŀƭƭȅ 

¶ /ƭƛŎƪ ƻƴ άAdd employeesέ ƻǇŜƴǎ ŀ ǇƻǇ-up menu with options άWorked on this invoiceέ and 

άCustomer ManagerέΥ 

 

¶ To delete a row, mark rows and press  button 

¶ Click  button to print the table 

¶ Click  button to save the table to Excel 
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The structure of the table  

The rows of the table  

At first there is one row header in the table ς άRemainderέΥ

 

 You can add two more ς άExpensesέ ŀƴŘκƻǊ άPayrollsέΥ 

 

 The sum of the invoice will be divided on the basis of άExpensesέ ŀƴŘ άPayrollsέ. 

άRemainderέ shows always the sum, which is left (undivided) from the total sum of the invoice. 
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The columns of the table  

There are ten columns in the table: confirmed, payroll date, employe, comments, duration, invoice 

sum, % of row, % of invoice, total, %. 

 

Type or add the data of values in columns. 

Please note! 

TƘŜǊŜ ŀǊŜ ǎŜǇŀǊŀǘŜ Ǌƻǿǎ ŦƻǊ ά% of rowέ ŀƴŘ ά% of invoiceέ. 

Mark the άpayroll dateέ manually if it is different from the invoice date. 

Payroll settings  

To save payroll settings go to Tools > Payroll. 

Prices 
You can add prices according to activity type, customer, case, employee, employee level or the 

combination of them. You can also use different currencies.  

Price on activity timing  

While entering data, LawTime offers most accurate price according to this case. For example, if there 

is no price to a case, LawTime offers you a price set to a customer. You can also choose an implied 

price (e.g. even if there is a price set to a customer, you can choose a prise set to bureau).  

You can also enter the price manually, ƛΦŜΦ ƛǘΩǎ ƴƻǘ ƳŀƴŘŀǘƻǊȅ ǘƻ ŎƘƻƻǎŜ the price from database. 

Adding new price  

To add new price, do one of the following: 

1. Subdivison άtǊƛŎŜǎέ in LawTime main ǿƛƴŘƻǿΦ /ƭƛŎƪ άbŜǿέ ǘƻ ŀŘŘ data. 

2. Add/open price data, by a click on  -button in data entry window.   

3. Click on Customer, Case, Employee Řŀǘŀ ǿƛƴŘƻǿ ǎǳōŘƛǾƛǎƛƻƴ έpricesέΦ 

Window for adding a new price  

You can add the following: 

¶ total value 

¶ currency 

¶ parameters of price (used for customers, cases, employees, employee levels) 
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Make your selections and the έNameέ-field will be automatically filled by LawTime.  

If necessary, enter the Name manually. 

To see the price in all options, matching to these parameters, ǎŜƭŜŎǘ έŀƭƭέΦ 

Combine price parameters. For example, you can make different prices, if: 

¶ ǘƘŜ ŎǳǎǘƻƳŜǊ ƛǎ ά¢ƘŜ ¦ƴƛǾŜǊǎƛǘȅ ƻŦ ¢ŀǊǘǳέΣ ǘȅǇŜ ƻŦ ŀŎǘƛǾƛǘȅ ƛǎ άǎǘǊŀǘŜƎƛŎ ǇƭŀƴƴƛƴƎέ 

¶ ǘƘŜ ŎǳǎǘƻƳŜǊ ƛǎ ά¢ƘŜ ¦ƴƛǾŜǊǎƛǘȅ ƻŦ ¢ŀǊǘǳέΣ ŜƳǇƭƻȅŜŜ ƭŜǾŜƭ is άƭŜŎǘǳǊŜǊέ 

¶ employee level is lawyer 

¶ ŀƭƭ ǇŀǊŀƳŜǘŜǊǎ ŀǊŜ ƳŀǊƪŜŘ ŀǎ άallέ όbase rates of activity types) 

While entering data, LawTime offers a price closest to selected parameters. 

¸ƻǳ Ŏŀƴ ŘŜƭŜǘŜ ǇǊƛŎŜ ƻƴƭȅ ƛŦ ǘƘŜǊŜΩǎ ƴƻ ǿƻǊƪ ǎŀǾŜŘ ǳǎƛƴƎ ǘƘƛǎ ǇǊƛŎŜΦ ¦ƴǘƛŎƪ έ!ŎǘƛǾŜέ will remove the 

price from selections. 

 
 

Subdivision of prices on customer and other windows  

You can see overviews of currently active prices in customer, cases, employee, employee level and 

activity type windows. 

Prices in the table are sorted in ascending order from specific to general. 

General prices are displayed in grey colour. For example, you see base rates and employee level 

prices in grey colour, customer and case specific prices are displayed in black. 

¢ƻ ǎŜŜ ƻƴƭȅ ŎǳǊǊŜƴǘƭȅ ŀŎǘƛǾŜ ǇǊƛŎŜǎΣ ǘƛŎƪ ǘƘŜ έ!ŎǘƛǾŜέ checkbox, untick to see all. 

/ƘƻƻǎŜ έ!ŎǘƛǾƛǘȅ ǘȅǇŜέ ȅƻǳ ǿŀƴǘ ƛƴŦƻǊƳation about (at first you will see activity type set in Tools > 

Options > Program settings > default activity type). 
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Prices in  LawTime  main window  

Prices in LawTime main window display the table of all prices. 

We recommend you to use customer, case etc window to view the specific price you’re interested 

in. 

To get the best overview of the table, use one of the following: 

¶ Sort, group, filter (see also on page 10) 

 

¶ Selection panel on the left-side of the main window. See also below. 
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Price settings  

 
Selections in the left-side panel of the main window: 

¶ View  - make a personal view using parameters you need 

¶ Quick selections to return to base rates 

¶ Filters to define prices: activity type, currency, customer, case, employee level, employee 

¶ Active price: 

¢ƛŎƪ ǘƘŜ έActiveέ checkbox ( ) to view only currently active prices. 

¦ƴǘƛŎƪ ǘƘŜ έActiveέ checkbox ( ) to view only currently inactive prices. 

aŀǊƪ ǘƘŜ έActiveέ checkbox grey to view all prices. 

 

 

¶ έOnly applied strictly to selectionέ checkbox helps you to specify filter selections: 

1)  to view prices of specific customer/case/etc and also 

general prices 

2)  to view prices only of specific customer/case etc  

¶ έDisplayέ ǎƘƻǿǎ the table according to selections 
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Adminis tration  

 

Employees 

Adding a new employee  and viewing data   

To add/open employee data, do one of the following: 

1. LawTime Ƴŀƛƴ ǿƛƴŘƻǿΣ ǎǳōŘƛǾƛǎƛƻƴ έ!ŘƳƛƴƛǎǘǊŀǘƛƻƴέ > ά9ƳǇƭƻȅŜŜsέΦ /ƭƛŎƪ άbŜǿέ to 

add new employee. Click on employee name to open data. 

2. To add/open employee data , click on  -button in any place LawTime offers a 

ŎƘƻƛŎŜ άemployeeέΦ 

Employee data  

¶ General 

General data of employee, user name, employee level etc. 

¢ƛŎƪ ƛƴ έ!ŎǘƛǾŜέ ŎƘŜŎƪōƻȄ ǎƘƻǿǎ ŜƳǇƭƻȅŜŜ ƛƴ ǎŜƭŜŎǘƛƻƴǎΦ 

 

By default, table shows only active employŜŜǎΦ ¢ƻ ǎŜŜ ŀƭƭ ŜƳǇƭƻȅŜŜǎΣ ŎƭƛŎƪ ƻƴ ŎƻƭǳƳƴ έ!ŎǘƛǾŜέ 

and then tick the ŎƘŜŎƪōƻȄ έ!ƭƭέΦ 
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¶ Privileges 

Specific privileges of employee. 

Privileges set on employee window are superior to employee level privileges. 

¶ Prices 

List of prices attached to employee. 

See also 

¶ Employee levels on page 39 

¶ User privileges on page 41 

¶ Prices on page 32 

Employee levels  

Adding a new employee level and viewing data  

Employee level represents a group or role of employees (e.g. attorney at law, accountant). 

To open employee level data, do one of the following: 

1. LawTime Ƴŀƛƴ ǿƛƴŘƻǿΣ ǎǳōŘƛǾƛǎƛƻƴ έ!ŘƳƛƴƛǎǘǊŀǘƛƻƴέ -> ά9ƳǇƭƻȅŜŜ ƭŜǾŜƭǎέΦ /ƭƛŎƪ 

άbŜǿέ ǘƻ ŀŘŘ ƴŜǿ ŜƳǇƭƻȅŜŜ ƭŜǾŜƭΦ /ƭƛŎƪ ƻƴ ŜƳǇƭƻȅŜŜ ƭŜǾŜƭ ƴŀƳŜ ǘƻ ƻǇŜƴ ŘŀǘŀΦ 

2. To add/open employee level data , click on  -button in any place LawTime offers a 

ŎƘƻƛŎŜ άemployee leǾŜƭέΦ   

Employee level data  

¶ General 

Name, short name, comments. 

 

¶ Privileges 

Employee level oriented privileges. 

These are default privileges for entire group of this employee level. 

Define specific privileges in employee window. 

¶ Prices 

List of prices attached to employee levels. 

See also 

¶ Employees on page 39 

¶ Prices on page 32 
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¶ See user privileges below 

Privileges  

Privileges on two levels  

Privileges are either allowed or denied, employee cannot enter or change privileges.  

User privileges are set on two levels: 

¶ Employee level oriented privileges. These are default privileges for entire group of this 

employee level. 

E.g. employee level Partner is alloǿŜŘ ǘƻ ǾƛŜǿ ŀƴŘ ŜŘƛǘ ƻǘƘŜǊ ǳǎŜǊΩs activities. 

 

¶ Specific privileges of employee. 

E.g. employee level Partner ƛǎ ŀƭƭƻǿŜŘ ǘƻ ǾƛŜǿ ŀƴŘ ŜŘƛǘ ƻǘƘŜǊ ǳǎŜǊΩǎ ŀŎǘƛǾƛǘƛŜǎΣ ōǳǘ ȅƻǳ Ŏŀƴ 

untick the checkbox (in privilege window) and this particular Partner does not have this 

privilege anymore. 
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Variou s privileges  

List of all user privileges. 

 

Colours of privileges  

LawTime uses different colours for different privilege levels to simplify administration and give the 

best overview. 

¶ Privileges, allowed on currently open unit (employee level or particular employee), are 

displayed in regular font style. 
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¶ Privileges, allowed to particular employee level, are displayed in grey colour. These are 

inherited privileges. 

 

¶ Privileges, changed after last saving, are displayed in bold black. 

 

¶ Privileges, changed from inherited to different and then back to inherited, are displayed in 

bold grey colour. 

 

See also 

¶ Employees on page 39 

¶ Employee levels on page 40 

 

Divisions 

Divisions - subdivisions, used to differentiate customers, cases, employees and invoices. 

Title έŘƛǾƛǎƛƻƴέ ƛǎ ŎƘŀƴƎŜŀōƭŜ όe.g. department, area, team, subject field etc). 

¢ƻ ŀŎǘƛǾŀǘŜ έŘƛǾƛǎƛƻƴǎέ Ǝƻ Tools > Options > Divisions > tick in checkbox. You can also change the title 

here. 

 

You can see divisions in customer, case etc selections after activating it. Add divisions in LawTime 

main window table by clicking . 
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Adding new division and viewing data  

To add/open division data, do one of the following: 

1. LawTime main windoǿΣ ǎǳōŘƛǾƛǎƛƻƴ έ!ŘƳƛƴƛǎǘǊŀǘƛƻƴέ > άŘƛǾƛǎƛƻƴǎέΦ /ƭƛŎƪ άbŜǿέ ǘƻ 

add new division. Click on division name to open data. 

2. To add/open division data , click on  -button in any place LawTime offers a choice 

άŘƛǾƛǎƛƻƴέΦ   

 

Activity type  

Adding new activity type and viewing data  

Activity type is used to describe different jobs (wages, phonecall etc). 

To add/open activity type data, do one of the following: 

1. LawTime Ƴŀƛƴ ǿƛƴŘƻǿΣ ǎǳōŘƛǾƛǎƛƻƴ έ!ŘƳƛƴƛǎǘǊŀǘƛƻƴέ > άŀŎǘƛǾƛǘȅ ǘȅǇŜǎέΦ /ƭƛŎƪ άbŜǿέ 

to add new activity type. Click on activity type name to open data. 

2. To add/open activity type data , click on  -button in any place LawTime offers a 

ŎƘƻƛŎŜ άŀŎǘƛǾƛǘȅ ǘȅǇŜέΦ   

Activity type data  

 

¶ General 

Name, short name, measurement, unit, comments, rounding on timing, rounding on invoices. 
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¶ Accounting 

Type (service, expense, others), VAT, other parameters.  

¶ Prices 

List of prices attached to activity type. 

Currencies  

Adding new currency  and viewing data  

To add/open currency data, do one of the following: 

1. LawTime Ƴŀƛƴ ǿƛƴŘƻǿΣ ǎǳōŘƛǾƛǎƛƻƴ έ!ŘƳƛƴƛǎǘǊŀǘƛƻƴέ -> άŎǳǊǊŜƴŎƛŜǎέΦ /ƭƛŎƪ άbŜǿέ ǘƻ 

add new currency. Click on currency name to open data. 

2. To add/open currency data , click on  -button in any place LawTime offers a choice 

άŎǳǊǊŜƴŎƛŜsέΦ   

Currency  data 

¶ General 

Code, name, current rate, comments. 

Name the base currency and fix the rate to 1. 
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Options  

 

¢ƻ ƻǇŜƴ ǎŜǘǘƛƴƎǎ ŎƭƛŎƪ έ¢ƻƻƭǎέ Ҕ έhǇǘƛƻƴǎέΦ 

  

  

Fields you see on Settings window come from employee (level?) privileges.  

Regular user view in My Settings: 

¶ My Settings: 

1) User interface language 

2) Timer functions 

3) Main window display 

¶ Program settings: 

1) SQL based user authentication 

2) Allow password saving 

3) Enable tasks  

4) Allow price on activity timing 
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5) Default currency 

6) Default activity type 

7) Error reporting ς program error condition is created to test error reporting. WARNING: 

Řƻ ƴƻǘ ŎƭƛŎƪ έ/ƭƻǎŜ ǇǊƻƎǊŀƳέ on error window because LawTime will then be closed and 

unsaved changes will be lost 

¶ Table printing ς margins (mm), styles (editable) 

¶ Invoice settings: 

1) Invoice numbers  (can be edited; take automatically from number series).  

Choose if the invoice number must be filled on printing, saving or confirming. 

2) Invoice calculations ς duration format, default VAt %, total rounding 

¶ Comment templates - ŜƴǘŜǊ ǘƘŜ ǘŜƳǇƭŀǘŜ ǘŜȄǘǎ ŘƛǎǇƭŀȅŜŘ ƛƴ ŀŎǘƛǾƛǘȅ ǿƛƴŘƻǿΩǎ ŎƻƳƳŜƴǘ 

field. Choose the language of texts 

¶ Payroll ς default texts on new payroll rows 

¶ Divisions: 

1) Tick the checkbox to use divisions 

2) Title texts ς language, singular, plural, short name. 

¶ Invoice texts ς default text rows for new invoices 

¶ Invoice printing: 

1) Language default 

2) Layouts 

3) Letterheads (header logo and footer texts) 

Database settings  

/ƭƛŎƪ έ¢ƻƻƭǎέ Ҕ έ5ŀǘŀōŀǎŜ ǎŜǘǘƛƴƎǎέ ǘƻ ƻǇŜƴ ǘƘŜ ǿƛƴŘƻǿΦ 

 

¶ Enter the name of a server and database 

¶ Authentication ς windows integrated or SQL server (user will be promted for password) 

¶ !ŦǘŜǊ ŜƴǘŜǊƛƴƎ ȅƻǳǊ ǎŜǘǘƛƴƎǎΣ ǘŜǎǘ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴΦ /ƭƛŎƪ άhYέ ǘƻ ǎŀǾŜ ǘƘŜ ǎŜǘǘƛƴƎǎ 


